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Preface

This preface covers:

Safety information

Howtousethisguide ........ ... . ... i
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Safety information

Safety information

Safety alert
words

MSDSs

Note: For general safety information, see this Preface and Appendix C, Safety on
page 23. When a hazard symbol and hazard type appear by a chemical name or
instrument hazard, see the “Safety” Appendix for the complete alert on the chemical
or instrument.

Four safety alert words appear in Applied Biosystems user documentation at points
in the document where you need to be aware of relevant hazards. Each alert
word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular
level of observation or action, as defined below:

IMPORTANT! — Indicates information that is necessary for proper instrument
operation, accurate chemistry kit use, or safe use of a chemical.

CAUTION! - Indicates a potentially hazardous situation that, if not avoided,
may result in minor or moderate injury. It may also be used to alert against
unsafe practices.

WARNING! - Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

DANGER! - Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury. This signal word is to be limited to the
most extreme situations.

The MSDSs for any chemicals supplied by Applied Biosystems or Ambion are
available to you free 24 hours a day. For instructions on obtaining MSDSs, see
“Obtaining MSDSs” on page 26.

IMPORTANT! For the MSDSs of chemicals not distributed by Applied Biosystems
or Ambion, contact the chemical manufacturer.

vi
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How to use this guide

Purpose of
this guide

Audience

Assumptions

Text conventions

User attention
words

The AmpliTag Gold® 360 DNA Polymerase Protocol provides all the information you
need to perform PCR over a wide range of DNA templates, including some of the
most challenging GC-rich sequences.

This guide is intended for biologists who have had some experience performing PCR.

This guide assumes that your thermal cycler has been installed by an
Applied Biosystems technical representative.

This guide uses the following conventions:

* Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

» [talic text indicates new or important words and is also used for emphasis.
For example:

Before analyzing, always prepare fresh matrix.

* A right arrow symbol ( » ) separates successive commands you select from a
drop-down or shortcut menu. For example:

Select File » Open » Spot Set.
Right-click the sample row, then select View Filter » View All Runs.

Two user attention words appear in Applied Biosystems user documentation. Each
word implies a particular level of observation or action as described below:

Note: — Provides information that may be of interest or help but is not critical to the
use of the product.

IMPORTANT! — Provides information that is necessary for proper instrument
operation, accurate chemistry kit use, or safe use of a chemical.

AmpliTag Gold® 360 DNA Polymerase Protocol vii
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AmpliTag Gold® 360 DNA
Polymerase Protocol

This chapter covers:

Product information. . .. ... ... 2
Workflow . . .o 5
Before youperform PCR. .. ... .. ... . . . 6
Perform PCR using AmpliTaq Gold® 360 DNA Polymerase . ................. 7
Analyze the results .. ... . i e 10
Troubleshooting. . . ... ... i 11
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AmpliTag Gold® 360 DNA Polymerase Protocol

Product information

Purpose of the  Use the AmpliTaq Gold® 360 DNA Polymerase to amplify with high specificity a
product wide range of fragments.

About AmpliTaq AmpliTaq Gold® 360 DNA Polymerase, when used with AmpliTaq Gold® 360
Gold® 360 DNA  Buffer, 10X and the optional 360 GC Enhancer, amplifies a wide range of DNA
Polymerase sequence contexts. AmpliTaq Gold® 360 DNA Polymerase is purified by an
additional proprietary separation process to reduce contaminating bacterial DNA
sequences from the enzyme preparation. This ultra-pure enzyme, in addition to its
hot-start capabilities, reduces false positives, amplifies low-level target sequences,
and promotes amplification of a variety of templates including those from bacteria
and the human genome. The enzyme is quality-control tested to ensure that, in a 5-
unit aliquot of the enzyme, bacterial 16S ribosomal RNA gene sequences are present
in low copy number.

About the 360 GC The 360 GC Enhancer is used for difficult-to-amplify templates, especially for
enhancer templates with high GC content. You can adjust the amount of 360 GC Enhancer to
optimize the PCR reaction. Amplicons that generate nonspecific products may
require small amounts of enhancer to improve specificity. Amplicons with high GC-
content require more enhancer.

About this  This protocol provides:
protocol + Procedures and guidelines on PCR using the AmpliTaq Gold® 360 DNA
Polymerase
* Information on troubleshooting PCR results
* A list of equipment and materials required for using the AmpliTaq Gold® 360
DNA Polymerase

For more information, refer to the documents shipped with your Applied Biosystems
PCR System.

Contents The AmpliTaq Gold® 360 DNA Polymerase contains:

+ AmpliTaq Gold® 360 DNA Polymerase
+ AmpliTaq Gold® 360 Buffer, 10X

* 25 mM Magnesium Chloride

* 360 GC Enhancer

Note: The 360 GC Enhancer, AmpliTaq Gold® 360 Buffer, 10X, and 25 mM
Magnesium Chloride are also available without enzyme.

Available kit AmpliTag Gold® 360 DNA Polymerase is available in the following packaging:
packaging

2 AmpliTag Gold® 360 DNA Polymerase Protocol



Product information

Part

Quantity number

Reagents sufficient for 80 x 50-pL reactions: 4398813
e AmpliTag Gold® 360 DNA Polymerase, 100 U

e AmpliTag Gold® 360 Buffer, 10X, 1 x 1.5 mL

e 360 GC Enhancer, 1 x 1.5 mL

e 25 mM MgCl,, 1 x 1.5 mL

Reagents sufficient for 200 x 50-pL reactions: 4398823
¢ AmpliTag Gold® 360 DNA Polymerase, 250 U

¢ AmpliTaq Gold® 360 Buffer, 10X, 1 x 1.5 mL

e 360 GC Enhancer, 1 x 1.5 mL

e 25 mM MgCl,, 1 x 1.5 mL

Reagents sufficient for 800 x 50-pL reactions: 4398833
AmpliTag Gold® 360 DNA Polymerase, 1000 U

AmpliTaq Gold® 360 Buffer, 10X, 4 x 1.5 mL

360 GC Enhancer, 4 x 1.5 mL

25 mM MgCl,, 4 x 1.5 mL

Reagents sufficient for 1200 x 50-puL reactions: 4398892
AmpliTag Gold® 360 DNA Polymerase, 6 x 250 U

AmpliTaq Gold® 360 Buffer, 10X, 6 x 1.5 mL

360 GC Enhancer, 6 x 1.5 mL

25 mM Magnesium Chloride, 6 x 1.5 mL

Reagents sufficient for 2400 x 50-pL reactions: 4398894
AmpliTag Gold® 360 DNA Polymerase, 2 x 1500 U

AmpliTaq Gold® 360 Buffer, 20X, 12 x 1.5 mL

360 GC Enhancer, 12 x 1.5 mL

25 mM Magnesium Chloride, 12 x 1.5 mL

Reagents sufficient for 4000 x 50-puL reactions: 4398896
¢ AmpliTag Gold® 360 DNA Polymerase, 5 x 1000 U

e AmpliTag Gold® 360 Buffer, 10X, 20 x 1.5 mL

e 360 GC Enhancer, 20 x 1.5 mL

e 25 mM MgCl,, 20 x 1.5 mL

Reagents sufficient for 20,000 x 50-puL reactions: 4398898
e AmpliTag Gold® 360 DNA Polymerase, 25 x 1000 U

¢ AmpliTag Gold® 360 Buffer, 10X, 100 x 1.5 mL

e 360 GC Enhancer, 100 x 1.5 mL

e 25 mM MgCl,, 100 x 1.5 mL

Reagents sufficient for 20,000 x 50-uL reactions: 4398900
¢ AmpliTag Gold® 360 DNA Polymerase, 1 x 25,000 U

e AmpliTaq Gold® 360 Buffer, 10X, 1 x 150 mL

e 360 GC Enhancer, 1 x 120 mL

e 25 mM Magnesium Chloride, 1 x 150 mL

AmpliTag Gold® 360 DNA Polymerase—standalone, 4398843
25,000 U, 1 x 5 mL
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AmpliTag Gold® 360 DNA Polymerase Protocol

. Part

Quantity number
AmpliTaq Gold® 360 Buffer, 10X Kit: 4398853
e AmpliTag Gold® 360 Buffer, 10X, 1 x 1.5 mL
e 360 GC Enhancer, 1 x 1.5 mL
e 25 mM Magnesium Chloride, 1 x 1.5 mL
AmpliTag Gold® 360 Buffer, 10X Kit: 4398863
e AmpliTag Gold® 360 Buffer, 10X, 6 x 1.5 mL
e 360 GC Enhancer, 6 x 1.5 mL
e 25 mM Magnesium Chloride, 6 x 1.5 mL
AmpliTaq Gold® 360 Buffer Kit: 4398872

e AmpliTag Gold® 360 Buffer, 10X, 1 x 150 mL
e 360 GC Enhancer, 1 x 120 mL
e 25 mM Magnesium Chloride, 1 x 150 mL

Storage Store the AmpliTaq Gold® 360 DNA Polymerase at —15 to —25 °C.
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Workflow

Workflow

The workflow for PCR using the AmpliTaq Gold® 360 DNA Polymerase:

Prepare the reaction mix

—

Prepare the reaction
plate or tubes

384-well plate 96-well plate

—

Set up the run method

g,

—

Load and run the plate
or tubes

Analyze the results

AmpliTag Gold® 360 DNA Polymerase Protocol 5



AmpliTag Gold® 360 DNA Polymerase Protocol

Before you perform PCR

Prevent Review “PCR good laboratory practices” on page 18.
contamination

Select an  You can perform PCR amplification with any of the instruments listed under
instrument and  “Thermal cyclers” on page 14. Use MicroAmp' " Optical 96-Well Reaction Plates
reaction plate (PN N8010560). Other recommended equipment and consumables are listed
beginning on page 14.

Calculate the Calculate the number of reactions to perform for each assay. In your calculations,
number of include extra reactions (approximately one extra reaction for every 10 required
required reactions) to provide excess volume for the volume lost during reagent transfers. For
reactions example, for a 96-well plate, prepare enough volume for approximately 110
reactions.

Note: You can run multiple PCRs on one reaction plate. Include controls for each
run on the plate.
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Perform PCR using AmpliTag Gold® 360 DNA Polymerase

Perform PCR using AmpliTaq Gold® 360 DNA Polymerase

Prepare the For the following hazards, see the complete safety alert descriptions in “Specific
chemical alerts” on page 29.

reaction mix

CHEMICAL HAZARD. AmpliTaq Gold® 360 DNA Polymerase, AmpliTaq

Gold® 360 Buffer, 10X.

IMPORTANT! Avoid generating bubbles when mixing the enzyme.

L.

Thaw AmpliTaq Gold® 360 Buffer, 10X, 25 mM Magnesium Chloride, INTP
mix, primers, template, and (optional) 360 GC Enhancer, then vortex both
reagents before use.

Mix AmpliTaq Gold® 360 DNA Polymerase by gently pipetting it up and down.

Combine the following components in an appropriate tube according to the
volumes that are shown in Table 1. Multiply the volume for one reaction
component (Table 1) by the total number of reactions, then add that volume to
the tube.

Table 1 PCR reaction mix

Volume Volume
per per
Component 25-uL 50-uL Final concentration
reaction = reaction
(u)* (uL)
PCR-grade water Variable Variable —
AmpliTaq Gold® 360 Buffer, 10X | 2.5 5 1X
25 mM Magnesium Chloride 1to4 2to 8 1.0 to 4.0 mMS$
dNTP mix 2# 4# 200 pM each
(Optional)360 GC Enhancer 0.5t0 5% | {to10% | N/A
AmpliTag Gold® 360 DNA 0.125 0.25 1.25 Units per 50 pL
Polymerase reaction$$

T If the DNA is difficult to amplify in a 25-pL reaction, performing the PCR in a 50-pL reaction may
give better results.

§ The optimal MgCl, concentration may vary depending on the primer and template that are used
and must be determined by experiment. In most cases, a final concentration of MgCl, at 2.0 mM
in the reaction mix works well.

# Contains a 10-mM solution of ANTP (2.5 mM each of dATP, dCTP, dGTP, and dTTP).

11 For targets with 65 to 75% GC, start with 2.5 L in a 25-pL reaction or 5.0 pL in a 50-pL reaction
(10% (v/v) of the reaction). For targets with >75% GC, start with
5 pL in a 25-pL reaction or 10 pL in a 50-pL reaction (20% (v/v) of the reaction). In general, if
increased specificity is required, add 0.5. to 1 yL 360 GC Enhancer per
25-pL reaction or add 1 to 2 pL 360 GC Enhancer per 50-uL reaction (2 to 5% (v/v) of the
reaction).

§§ For some difficult-to-amplify targets, up to 5.0 U per 50 pL of reaction can be added.

Cap the tube.

Gently vortex the tube on a low setting for no more than 5 seconds to mix the
components.

AmpliTag Gold® 360 DNA Polymerase Protocol
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6.

10.

Prepare the 1.

reaction plate or

tubes 7

Centrifuge the tube briefly to spin down the contents and to eliminate air
bubbles from the solution.

Dispense equal volumes of the PCR reaction mix to the reaction plate or into
PCR tubes (see Table 1).

Place the plate in a MicroAmp'" Splash-Free 96-Well Base or place the tubes in
a MicroAmp"" 96-well Base. Keep the plate or tubes in their respective bases
throughout the remainder of the protocol.

Seal the plate with MicroAmp"" Clear Adhesive Film or cap the tubes with
MicroAmp'" 8-Cap Strips.

Centrifuge the plate or tubes to collect the liquid at the bottom of the wells.

Prepare primers and DNA to their appropriate working dilutions (see Table 2).
For multiple PCR assays, prepare a master mix of components.

With the plate or tubes in the appropriate base, remove the seal from the plate or
open the tubes.

Add primers and DNA to the appropriate wells or tubes according to Table 2.
Include the no-template controls.

Table 2 Primer and DNA mix for PCR reactions

Volume Volume

per per
Component 25-puL 50-pL Final concentration
reaction = reaction

(uL)* (wL)
Primer 1 05t02.5 1to5 0.2 to 1.0 uMS
Primer 2 05t025 1to5 0.2 to 1.0 yM$
DNA Variable? | Variable* | <1 pg/reaction*
Total PCR volume 25 50 —

T If the DNA is difficult to amplify in a 25-pL reaction, performing the PCR in a 50-pL
reaction may give better results.

§ Lowering the primer concentration reduces potential secondary products.

# For a no-template control, add an equivalent volume of water.

11 Preferably >10* copies of template but <1 pg DNA/reaction

Seal the plate with MicroAmp" Clear Adhesive Film or cap the tubes with
MicroAmp™™ 8-Cap Strips.

Centrifuge the plate or tubes to collect the liquid at the bottom of the wells or
the tubes. Ensure that the wells are uniformly filled.

AmpliTag Gold® 360 DNA Polymerase Protocol



Perform PCR using AmpliTag Gold® 360 DNA Polymerase

Set up the run  Set the:

method » Thermal cycling conditions (see Table 3):

Table 3 Three-temperature thermal cycling on a a Veriti™,
GeneAmp® PCR System 9700, or 2720 Thermal Cycler

Stage Step Temp. Time
Holding Activation of AmpliTaq 95 °C 5to 10 min#
Gold® 360 DNA
Polymerase
Cycling Denature 95 °C 15 to 30 sec$
(25to .
40 cycles) Anneal Primer T, * 30 sec*
Extend 72 °C 60 sec/kb
Holding Final Extension 72 °C 7 min
Holding Final hold 4°C )

1 See “Adjusting the hold period for activation” in the AmpliTag Gold® 360 DNA
Polymerase Protocol, Appendix B.

§ For amplicons that are >2 kb, denature for 15 seconds. For amplicons that are <2 kb,
denature for
30 seconds.

# Although any primer can be used with this product, Applied Biosystems recommends
using primers with T ;s >55 °C. Use the Primer T, calculator on an Applied Biosystems
thermal cycler, or go to www.appliedbiosystems.com/support/techtools/calc.

11 Thirty seconds for denaturation and annealing is adequate when you use Veriti™ or
GeneAmp® PCR System thermal cyclers that display a calculated sample temperature.
Some models of thermal cyclers may require longer times.

* Ramp speed or mode: Standard
* Reaction volume (uL): 25 or 50

—

Load and run the Remove the plate or PCR tubes from the base.

plate or tubes

N

Use a MicroAmp™ Optical Film Compression Pad when you use a MicroAmp™
Clear Adhesive Film.

Load the reaction plate or tubes into a PCR instrument.
Start the run.

Unload the reaction plate or tubes after the run is complete.

A

Store the plate or tubes at 4 °C or at —15 to —25 °C for long-term storage.

For more Refer to the user guide or getting started guides for your PCR system for more
information  information about setting up the experiment, using and maintaining the instrument,
and performing instrument calibrations.

AmpliTag Gold® 360 DNA Polymerase Protocol 9
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Analyze the results

AWARNING! CHEMICAL HAZARD. Ethidium bromide.

Check the purity  Analyze the PCR amplification products by agarose gel electrophoresis.

of the PCR

product IMPORTANT! To prevent contamination, never bring amplified PCR products into
the PCR setup area.

1.

Obtain a 1% agarose gel with ethidium bromide stain. You can use a gel of up to
3% agarose with ethidium bromide stain. Set up the electrophoresis apparatus
and running buffer according to the manufacturer’s instructions.

Add an aliquot of the PCR product to a well of a new plate or to an appropriate
new tube. Add an appropriate volume of gel-loading buffer to the PCR-product
aliquot. For example, add 1 pLL of 10X gel-loading buffer to a 9-uL aliquot of
PCR reaction.

Mix the PCR-product aliquot and buffer in the wells by pipetting up and down,
or briefly vortex the samples in the tubes. Spin the plate or pulse-spin the tubes.

Dispense the entire volume of the buffer-PCR product aliquot from each well or
tube into a well of the gel.

Into one well of the gel, load a DNA-ladder marker appropriate to the PCR
product length.

Run the gel at the voltage or time appropriate to amplicon length and agarose
percentage so that the samples run 1/3 to 1/2 the length of the gel. Do not run
the dye off the gel.

Place the gel on a UV transilluminator. Verify that each lane with a
PCR-product aliquot contains one distinct band.

For more Refer to the getting started guides for your PCR system for more information about
information  analyzing a PCR results.

10
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Troubleshooting

Troubleshooting

Observation

Possible cause

Recommended action

Nonspecific
amplification
with or without
a product
band

Carryover contamination

¢ Use the GeneAmp® PCR Carry-Over
Prevention Kit (PN N8080068).

¢ Dispose of reagents, make fresh
reagents, then repeat the PCR.

e Use 1to 2 pL of 360 GC Enhancer in
a 50 pL reaction. Use the 360 GC
Enhancer only if there are nonspecific
products or products with >65% GC
(see “Prepare the reaction mix” on
page 7).

Denaturation temperature is too low or
too high

Adjust the temperature in increments of
1 degree Celsius. If you have a Veriti™
thermal cycler, adjust the VeriFlex™
Block in increments of 1 degree Celsius
for up to six different temperatures.

Nonspecific priming

Increase the annealing temperature in
increments of 1 to 2 degrees Celsius.

Primer design is not optimal

Review primer design and composition.

AmpliTag Gold® 360 DNA Polymerase Protocol
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Observation

Possible cause

Recommended action

Low levels of
PCR product
or no product
band visible

Template concentration is too low

Increase the sample concentration.

Experimental sample DNA is damaged
or degraded

Add more DNA or use sample that has
been processed to minimize shearing
and nicking.

Denaturation time is too short or too
long

Adjust the time in increments of
5 seconds.

Denaturation temperature is too low or
too high

Adjust the temperature in increments of
1 degree Celsius. If you have a Veriti™
thermal cycler, adjust the VeriFlex™
Block in increments of 1 degree Celsius
for up to six different temperatures.

Annealing/extension temperature is too
high

Lower the temperature in increments of
2 degrees Celsius. If you have a Veriti™
thermal cycler, adjust the VeriFlex™
Block in increments of 2 degrees Celsius
for up to six different temperatures.

Annealing/extension time is too short

Increase the time in increments of
15 seconds.

Cycle number is too low

Increase the cycle number in increments
of three cycles.

Primer design is not optimal

Review primer design and composition.

Preincubation/activation time is not
sufficient

Increase the pre-PCR heat step in
increments of 1 minute, or use the “Time
Release” protocol (see “Adjusting the
hold period for activation” on page 19).

Product band

Carryover contamination

¢ Use the GeneAmp® PCR Carry-Over

is smeared Prevention Kit (PN N8080068).
¢ Dispose of reagents, make fresh
reagents, then repeat the PCR.
Denaturation time is too short or too Adjust the time in increments of
long 5 seconds.
Denaturation temperature is too low Increase the temperature in increments
of
1 degree Celsius.
Annealing/extension time is too long Shorten the time in increments of
15 seconds.
Cycle number is too high Shorten the cycle number in increments
of 3 cycles.
Experimental sample DNA is degraded | Test a new aliquot of sample.
12 AmpliTag Gold® 360 DNA Polymerase Protocol
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Materials and equipment notincluded ................ ... .. ... ... .. ..... 14

Thermal Cyclers. . . ... e 14

Other equipment and consumables . ................ ... ..., 14
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Appendix A Ordering Information

Materials and equipment not included

Thermal cyclers

Other equipment
and consumables

In addition to the reagents supplied, the items listed in the following table are

required:

Item# Applied Biosystems PN
Veriti™ 60-Well Thermal Cycler 4384638
Veriti™ 96-Well Fast Thermal 4375305
Cycler
Veriti™ 96-Well Thermal Cycler 4375786
Veriti™ 384-Well Thermal Cycler 4388444
2720 Thermal Cycler 4359659
Aluminum 96-Well GeneAmp® 4314445
PCR System 9700, Sample Block
Module
Gold-plated 96-Well GeneAmp® 4314878
PCR System 9700
T Only one thermal cycler or one PCR system is required.
Item Source
MicroAmp™ Optical 96-Well Reaction Plates Applied Biosystems

MicroAmp™ Splash-Free 96-Well Base

(PN N8010560)

Applied Biosystems
4312063

MicroAmp™ 8-Tube Strip, 0.2 mL
MicroAmp™ 8-Cap Strip

MicroAmp™ 96-well Base

Applied Biosystems
(PN N8010580)

Applied Biosystems
(PN N8010535)

Applied Biosystems

N8010531
dNTP Mix Applied Biosystems
(PN N8080260)
MicroAmp™ 96-Well Tray/Retainer Set, 10 sets Applied Biosystems

(PN 403081)

Nuclease-free water (not DEPC-treated), 500 mL Applied Biosystems

(PN AM9930)

MicroAmp™ Clear Adhesive Film

Applied Biosystems
(PN 4306311)

MicroAmp™ Optical Film Compression Pad*. Applied Biosystems

Centrifuge with plate adapter

(PN4312639

Major laboratory
supplier (MLS)$

14
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Materials and equipment not included

Source

Pre-cast agarose gels, 1% up to 3% with MLS
ethidium bromide stain

Agarose MLS
Disposable gloves MLS
Electrophoresis apparatus MLS
Microcentrifuge MLS
Pipettes, positive-displacement or air- MLS
displacement

Pipette tips with filter plugs MLS
Polypropylene tubes MLS
TBE buffer MLS
TE buffer MLS
Vortex MLS
Disposable gloves MLS
Microcentrifuge MLS
1.5-mL microcentrifuge tubes MLS
Tris-EDTA (TE) buffer, pH 8.0 MLS
Vortexer MLS

T See instrument manual for compatibility.

§ For the MSDS of any chemical not distributed by Applied Biosystems, contact the
chemical manufacturer. Before handling any chemicals, refer to the MSDS provided
by the manufacturer, and observe all relevant precautions.

For more product recommendations, visit the PCR technology page at:

www3.appliedbiosystems.com/applicationstechnologies/PCR/index.htm?newGl

obalNav=true

AmpliTag Gold® 360 Master Mix Protocol
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Appendix B Guidelines for
Designing PCR Assays

This appendix covers:

PCR good laboratory practices ... .....................
Select the ampliconsite. . ............... ... ... .......
Adjust thermal cycling ........... ... ... ... ... ......
Optimize the PCR conditions . ........................

AmpliTag Gold® 360 Master Mix Protocol
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Appendix B Guidelines for Designing PCR Assays

PCR good laboratory practices

General PCR  When preparing samples for PCR amplification:

practices » Use a positive-displacement pipette or aerosol-resistant pipette tips.

+ Follow proper pipette-operating techniques to prevent aerosols.

» Wear clean gloves and a clean lab coat (not previously worn while handling
amplified PCR products or used during sample preparation).

* Change gloves whenever you suspect that they are contaminated.
* Maintain separate areas and dedicated equipment and supplies for:
— Sample preparation
— PCR setup
— PCR amplification
— Analysis of PCR products
* Never bring amplified PCR products into the PCR setup area.

* Open and close all sample tubes carefully. Try not to splash or spray PCR
samples.

» Keep reactions and components capped as much as possible.

* Clean lab benches and equipment periodically with 10% bleach solution. Use
DNAZap" Solution (PN AM9890).

18 AmpliTag Gold® 360 Master Mix Protocol



Select the amplicon site

Select the amplicon site

Guidelines

Using Primer Express® Software, select an amplicon site within the target sequence
(refer to the Primer Express® Version 3.0 Getting Started Guide and Sofiware Help).

* Design primer pairs according to Primer Express Software guidelines.

» Use a primer pair that is specific to the target gene and does not amplify
pseudogenes or other related genes.

+ Test the primer pairs, then select the primer pair that produces the largest
amount of specific product and the least amount of non-specific product. To
determine specific product, compare migration through an agarose gel of
amplicons to that of the DNA bands of known length in a DNA ladder.

Adjust thermal cycling

Adjusting the
hold period for
activation

Adjusting
denaturation
conditions

Adjusting
annealing
conditions

For general PCR runs, Applied Biosystems recommends a pre-PCR activation setup
of 95 °C for 10 minutes. Perform a titration of pre-PCR activation times (2 to 10
minutes in 1-minute intervals) to find the best enzyme activity for your reaction. You
can also activate AmpliTaq Gold® 360 DNA Polymerase to release active enzyme
slowly over time (time release). Time release allows enzyme activity to increase with
cycle number as the amount of template increases. This type of PCR can be
accomplished

* With limited activation during the pre-PCR hold period
or
* Without activation during the pre-PCR hold period

In a “time-release” protocol, the enzyme is released slowly so that the enzyme
concentration matches the template concentration, thereby increasing enzyme
specificity. When no or limited (1-to-2 minute) pre-PCR activation is used, the
enzyme is released gradually during the denaturation step (95 °C for 15 to 30
seconds) of each cycle. Because the enzyme is released slowly, up to 5 additional
cycles may be required.

Limiting the amount of active enzyme at the beginning of the amplification reaction
enhances specificity in the early PCR cycles.

* In the early cycles, make sure that your DNA template is completely denatured.

* Do not exceed a denaturation temperature of 95 to 96 °C (Gelfand and White,
1990).

+ A denaturation period of 30 seconds is adequate when using Veriti' and
GeneAmp® PCR System thermal cyclers with a calculated in-tube temperature.
Some models of thermal cyclers may require longer denaturation times.

+ For increased product specificity, use annealing temperatures higher than 45 °C
(Saiki, Gelfand, and Stoffel, 1988; Rychlik, Spencer, and Rhoads, 1990).
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Adjusting
extension
conditions

Determine the optimum annealing temperature by testing at increments of 5 or
fewer degrees Celsius until the maximum specificity is reached.

Computer programs that calculate primer melting temperatures (T,,) can help
you narrow the range of annealing temperatures to test. For such a T, calculator,
go to http://www.appliedbiosystems.com, then select Services & Support »
Technical Tools » T, Calculator. The GeneAmp® PCR System 9700
Thermal Cycler also contains a T, calculator.

Thirty seconds is adequate annealing time when using the Veriti" and
GeneAmp PCR System thermal cyclers with a calculated in-tube temperature.
Some models of thermal cyclers may require longer annealing times.

The length of the target sequence affects the required extension time. Longer
targets require increased extension times. In general, allow an extension time of
approximately 60 seconds per 1000 bases at 72 °C.

As the amount of DNA increases, the number of DNA polymerase molecules
may become limiting. Compensate for this limitation by increasing the
extension time in later cycles.

Optimize the PCR conditions

Optimizing
template
concentration

Optimizing
enhancer
concentration

* The DNA segment to be amplified from the template can be up to 4 kb long

(Jeftreys et al., 1988), although 100 to 1000 bases are more typical and easier to
amplify.

Start with enough copies of the template to obtain a signal after 25 to 30 cycles.
More than 10 # copies but less than 1 ug of human genomic DNA per 50-uL
reaction is the recommended range.

If the target DNA concentration is low, you may need more than 35 cycles to
produce sufficient product for analysis. As few as 1 to 10 target copies can be
amplified (Saiki, Gelfand, Stoffel, 1988; Chou et al., 1992). Validation for low-
copy-number amplifications is best done for an average of 5 to 10 target
molecules per sample to avoid statistical false negatives.

The 360 GC Enhancer helps amplify amplicons that are difficult to amplify,
including amplicons that are GC-rich or have GC-repeats or that generate
nonspecific products.

In a 50-pL reaction, for targets with:
* 65 to 75% GC, start with 5 pL.
* >75% GC, start with 10 pL.

In general, if increased specificity is required, add 1 to 2 pLL per 50-pL reaction.

The 360 GC Enhancer can reduce nonspecific amplification and improve the yield of
specific products. However, excessive use of the 360 GC Enhancer can reduce yield,
particularly for non-GC-rich amplicons.

20
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Optimize the PCR conditions

Optimizing
Magnesium
Chloride
concentration

Optimizing dNTP
concentration

Optimizing
enzyme
concentration

The magnesium ion concentration that is required for optimal PCR amplification
depends on the specific set of primers and template.

Too much or too little MgCl, reduces amplification efficiency or results in
amplification of non-target sequences. The optimal MgCl, concentration must be
determined by experiment.

To determine the optimum MgCl, concentration for each primer set:

» Use the supplied 25 mM MgCl, to adjust the magnesium ion concentration.

* Vary the concentration of MgCl, around 1.8 mM. A typical range is
1.0 to 4.0 mM.

» Raise the MgCl, concentration in the reaction mix proportionately if the
samples contain EDTA, citrate, or other chelators.

» Adjust the MgCl, concentration in parallel with significant changes in the
concentration (higher or lower) of sample DNA or dNTPs to keep the free
magnesium ion concentration constant. For example, reduce the concentration
of ANTP from 200 pM each to 40 uM each, and reduce the MgCl, concentration
from the higher concentration to 640 uM.

The dNTP concentration that is recommended for PCR is 200 uM for each dNTP. If
the blend of ANTPS is changed, and the concentration of any one dNTP is
significantly different from the other dNTPs, then AmpliTaq Gold® 360 DNA
Polymerase tends to misincorporate, slow down, and/or terminate prematurely (Innis
et al., 1988). Lower concentrations of ANTPs (40 pM) tend to promote polymerase
fidelity (Eckert and Kunkel, 1992).

For difficult-to-amplify targets, increasing the AmpliTaq Gold® 360 DNA
Polymerase up to 5 U per 50 uL reaction may improve the yield.
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Chemical hazard warnings . ............... .ttt 24
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Chemical hazard warnings

WARNING! CHEMICAL HAZARD. Before handling any chemicals, refer
to the Material Safety Data Sheet (MSDS) provided by the manufacturer, and
observe all relevant precautions.

WARNING! CHEMICAL HAZARD. All chemicals in the instrument,
including liquid in the lines, are potentially hazardous. Always determine what
chemicals have been used in the instrument before changing reagents or
instrument components. Wear appropriate eyewear, protective clothing, and
gloves when working on the instrument.

WARNING! CHEMICAL HAZARD. Four-liter reagent and waste bottles
can crack and leak. Each 4-liter bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked
in the upright position. Wear appropriate eyewear, clothing, and gloves when
handling reagent and waste bottles.

WARNING! CHEMICAL STORAGE HAZARD. Never collect or store
waste in a glass container because of the risk of breaking or shattering.
Reagent and waste bottles can crack and leak. Each waste bottle should be
secured in a low-density polyethylene safety container with the cover fastened
and the handles locked in the upright position. Wear appropriate eyewear,
clothing, and gloves when handling reagent and waste bottles.

24
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Chemical safety guidelines

Chemical safety guidelines

To minimize the hazards of chemicals:

Read and understand the Material Safety Data Sheets (MSDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals or
hazardous materials. (See “About MSDSs” on page 26.)

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood). For additional
safety guidelines, consult the MSDS.

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the MSDS.

Comply with all local, state/provincial, or national laws and regulations related
to chemical storage, handling, and disposal.
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MSDSs

About MSDSs Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with
shipments of hazardous chemicals to new customers. They also provide MSDSs with
the first shipment of a hazardous chemical to a customer after an MSDS has been
updated. MSDSs provide the safety information you need to store, handle, transport,
and dispose of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to
replace the appropriate MSDS in your files.

Obtaining The MSDS for any chemical supplied by Applied Biosystems is available to you free
MSDSs 24 hours a day. To obtain MSDSs:

1. Go to www.appliedbiosystems.com, click Support, then select MSDS.

2. In the Keyword Search field, enter the chemical name, product name, MSDS
part number, or other information that appears in the MSDS of interest. Select
the language of your choice, then click Search.

3. Find the document of interest, right-click the document title, then select any of
the following:
* Open — To view the document
* Print Target — To print the document

» Save Target As — To download a PDF version of the document to a
destination that you choose

Note: For the MSDSs of chemicals not distributed by Applied Biosystems, contact
the chemical manufacturer.

Chemical waste hazards

ﬁ CAUTION! HAZARDOUS WASTE. Refer to Material Safety Data Sheets
and local regulations for handling and disposal.

ﬁ WARNING! CHEMICAL WASTE HAZARD. Wastes produced by Applied
Biosystems instruments are potentially hazardous and can cause injury, illness,
or death.

WARNING! CHEMICAL STORAGE HAZARD. Never collect or store
waste in a glass container because of the risk of breaking or shattering.
Reagent and waste bottles can crack and leak. Each waste bottle should be
secured in a low-density polyethylene safety container with the cover fastened
and the handles locked in the upright position. Wear appropriate eyewear,
clothing, and gloves when handling reagent and waste bottles.
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Chemical waste safety guidelines

Chemical waste safety guidelines

To minimize the hazards of chemical waste:

Waste disposal

Read and understand the Material Safety Data Sheets (MSDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle,
or dispose of chemical waste.

Provide primary and secondary waste containers. (A primary waste container
holds the immediate waste. A secondary container contains spills or leaks from
the primary container. Both containers must be compatible with the waste
material and meet federal, state, and local requirements for container storage.)

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood). For additional
safety guidelines, consult the MSDS.

Handle chemical wastes in a fume hood.
After emptying a waste container, seal it with the cap provided.

Dispose of the contents of the waste tray and waste bottle in accordance with
good laboratory practices and local, state/provincial, or national environmental
and health regulations.

If potentially hazardous waste is generated when you operate the instrument, you
must:

Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure the health and safety of all personnel in your laboratory.

Ensure that the instrument waste is stored, transferred, transported, and disposed
of according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.
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Biological hazard safety

General
biohazard WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
warning infectious agents, and blood of humans and other animals have the potential to

transmit infectious diseases. Follow all applicable local, state/provincial,
and/or national regulations. Wear appropriate protective equipment, which
includes but is not limited to: protective eyewear, face shield, clothing/lab coat,
and gloves. All work should be conducted in properly equipped facilities using
the appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and
company/institution requirements before working with potentially infectious
materials. Read and follow the applicable guidelines and/or regulatory
requirements in the following:

+ U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories (stock no. 017-040-
00547-4; bmbl.od.nih.gov)

* Occupational Safety and Health Standards, Bloodborne Pathogens (29
CFR§1910.1030; www.access.gpo.gov/
nara/cfr/waisidx_01/29¢fr1910a_01.html).

* Your company’s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at:

www.cdc.gov
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Chemical alerts

Chemical alerts

General alerts for May cause eye, skin, and respiratory tract irritation. Read the MSDS, and follow the
all chemicals handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

Specific -ACHEMICAL HAZARD. AmpliTaq Gold® 360 DNA Polymerase.
chemical alerts

'ACHEMICAL HAZARD. AmpliTaq Gold® 360 Buffer, 10X.

AWARNING! CHEMICAL HAZARD. Ethidium bromide causes eye, skin,
and respiratory tract irritation and is a known mutagen (that is, it can change genetic
material in a living cell and has the potential to cause cancer).
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Glossary

amplicon
biological
replicates
cycling stage
diluent

forward primer

holding stage

melting
temperature (T,,,)

mode
negative control

(NC)

no-template
control (NTC)

quantity

ramp

A segment of DNA amplified during PCR.

Reactions that contain identical components and volumes, but evaluate separate
samples of the same biological source (for example, multiple samples of the same
liver tissue). See also technical replicates.

In the thermal profile, a stage that is repeated. A cycling stage is also called an
amplification stage.

A reagent used to dilute a sample or standard before it is added to the PCR reaction.
The diluent can be buffer or water.

Oligonucleotide that flanks the 5° end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.

In the thermal profile, a stage that can include one or more steps. You can add a
holding stage to the thermal profile to activate enzymes, to inactivate enzymes, or to
incubate a reaction.

In melt-curve experiments, the temperature at which 50% of the DNA is double-
stranded and 50% of the DNA is dissociated into single-stranded DNA. The T,, is
displayed in the melt curve.

See ramp speed.

The task for targets in wells that contain water or buffer instead of sample. No
amplification of the target should occur in negative control wells. Also called no
template control (NTC).

See negative control (NC).

In quantitation experiments, the amount of target in the samples. Absolute quantity
can refer to copy number, mass, molarity, or viral load. Relative quantity refers to the
fold-difference between normalized quantity of target in the sample and normalized
quantity of target in the reference sample.

The rate at which the temperature changes during the instrument run. The ramp is
defined as a percentage. The ramp for the melt curve step is defined as a temperature
increment. In the graphical view of the thermal profile, the ramp is indicated by a
diagonal line.
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Glossary

ramp speed

reaction mix

replicate group
replicates

reverse primer

reverse
transcriptase

run method
sample

stage

step

target

technical replicates

thermal profile

Speed at which the temperature ramp occurs during the instrument run. For optimal
results using the AmpliTaq Gold® 360 DNA Polymerase, Applied Biosystems
recommends using the standard ramp speed.

A solution that contains all components to run the PCR reaction, except for the
template (sample, standard, or control).

A set of identical reactions in an experiment.
See biological replicates or technical replicates.

An oligonucleotide that flanks the 3’ end of the amplicon. The reverse primer and
the forward primer are used together in PCR reactions to amplify the target.

An enzyme that converts RNA to cDNA. Reverse transcriptase is added to the PCR
reaction to perform 1-step RT-PCR.

Definition of the reaction volume and the thermal profile for the instrument run.
The template that you are testing.

In the thermal profile, a group of one or more steps. In core PCR, there are two types
of stages: holding stage (including pre-PCR read and post-PCR read) and cycling
stage (also called amplification stage).

A component of the thermal profile. For each step in the thermal profile, you can set
the ramp rate (ramp increment for melt-curve steps), hold temperature, and hold time
(duration).

The nucleic acid sequence that you want to amplify and detect.

Identical reactions that contain identical components and volumes and that evaluate
the same sample.

See also biological replicates.

Part of the run method that specifies the temperature, time, and ramp for all steps and
stages of the PCR instrument run.

See melting temperature (T,,).

34

AmpliTag Gold® 360 DNA Polymerase Protocol



Documentation and Support

Related documentation

You can download the following documents and other product-support documents
from:

http://docs.appliedbiosystems.com/search.taf

Document Part number
AmpliTaqg Gold® 360 DNA Polymerase 4398303
Product Insert
AmpliTag® 360 DNA Polymerase 4398953
Quick Reference Card
Applied Biosystems Veriti™ Thermal 4375799
Cycler User Guide
GeneAmp® PCR System 9700 Base 4303481

Module User’s Manual

GeneAmp® PCR System 9700 96- 4316011
Well Sample Block Module
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Documentation and Support

How to obtain support

For the latest services and support information for all locations, go to
www.appliedbiosystems.com, then click the link for Support.

At the Support page, you can:
* Access worldwide telephone and fax numbers to contact Applied Biosystems
Technical Support and Sales facilities.
» Search through frequently asked questions (FAQs)
* Submit a question directly to Technical Support

* Order Applied Biosystems user documents, MSDSs, certificates of analysis,
and other related documents

* Download PDF documents
+ Obtain information about customer training
» Download software updates and patches

Send us your Applied Biosystems welcomes your comments and suggestions for improving its
comments user documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is for submitting comments and suggestions
relating only to documentation. To order documents, download PDF files, or for help
with a technical question, see “How to obtain support” above.
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